
Welcome to the WinAsks Professional tutorial!

This guide will let you discover and use all the main program functionalities. The tutorial is divided into 
four main sections and each one of them refers to a specific phase of the use of a questionnaire or 
survey.

Each topic of this tutorial can be printed; this way you can consult it while using the program.
To have further information you can consult the presentation, the on-line help and the user manual.
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 Setting general options

Before you begin to create a questionnaire / survey, it's useful, although not necessary, to 
proceed immediately to set its general options.

After selecting the New | Questionnaire command in the File menu (or button  on the 
toolbar), WinAsks Editor shows the window for questionnaires management.

Select now the Options... command in the Questionnaire menu ( or press SHIFT + F11): the 
window for general options setting is divided in two main sections: Standard and Advanced.
Standard options refer to basic functionalities for managing the questionnaire / survey, while 
advanced options, as the name itself says, refer to more advanced features.

Select the Sequence | Random option; this way questions will be shown in a random order, 
and not in the order of their insertion.

For the moment do not change the other options values and press Ok.

 Next lesson: Adding questions 



 Adding questions

 Previous lesson: Setting general options 

If you select command Add command in the Record menu (or press button  on the toolbar or
press F5) you can add a question to the questionnaire / survey.

WinAsks Editor Professional provides 4 kinds of questions, each one of them can be selected 
pressing the correspondent button.

 Multiple choice
 Insertion
 True / False
 Association

Select Multiple choice with 4 answers and, in the first text box, insert the following question: 
"When did C. Columbus discover America?" (without quotation marks).
Now you can insert 4 different answers in the second text box, using the correspondent tabs. In 
the first tab insert "1292", in the second "1392", in the third "1492" and finally in the fourth 
"1592". 
In the third text box you can also insert some comments: WinAsks Editor provides 6 kinds of 
comments:

Before: this comment is visualized before showing the question
Right:    this comment is visualized if the answer is right
Null: this comment is visualized if the answer is null
Wrong: this comment is visualized if the answer is wrong
Always: this comment is always visualized
Never: this comment is never visualized

Select the Right tab and insert "Ok, you're right!"; select the Null and insert "Why didn't you 
answer?"; select the Wrong tab and insert "You didn't know it, did you?".
Now you must choose the right answer among the entered ones: to do it, select option button
number 3 on the left.
For this question type (multiple choice) you can also choose some hints that will be shown if 
the user asks for: select check boxes number 2 and 3.
Let's add now an image to the question: select Associate object | Image command in the 
Record menu, choose an image and press Ok.
We've finished! To confirm the entered question, select the Confirm command in the Record
menu (or press the  button on the toolbar or press F8).

Now let's add the second question: select again the    Add command in the Record menu 
and choose the Insertion type by clicking the relative button.
In the first text box enter the question :"Which is the biggest planet in our Solar System?". 
In the second text box (Answer 1) insert the right answer "Jupiter" (the other tabs are used 
for alternative right answers).



Select the Confirm command in the Record menu.

Let's add the third question: select again the Add command in the Record menu and choose
the True / False type with 4 answers clicking the relative button.
In the first text box insert the question "The following programs have been created by 
Microsoft". 
In the first tab of the second text box insert "Windows", in the second tab "Paradox", in the 
third "Excel" and in the fourth "Approach".
Now choose if each answer is true or false using the correspondent control boxes on the left: 
set T, F, T, F.
To confirm the entered answer, select the Confirm command in the Record menu.

Now let's add the last question: select again the Add command in the Record menu and 
choose the Association type with 4 answers clicking the relative button.
In the first text box insert the question "Associate every event with the year in which it 
happened". In the first tab of the second box insert "World War One", in the second tab 
"Columbus discovers America", in the third "World War Two", in the fourth "J. F. Kennedy is 
murdered".
In the first text box on the left (Associations) insert "1966", in the second "1914", in the third 
"1492", in the fourth "1939".
In the boxes below, select associations 1 - B, 2 - C, 3 - D, 4 -A.
To confirm the entered question, select the Confirm command in the Record menu.

 Next lesson: Deleting, inserting and editing questions 



 Deleting, inserting and editing questions

 Previous lesson: Adding questions

After creating a questionnaire / survey with 4 questions (see previous lesson), let's delete 
one of these questions. Show question number 2 selecting the Next or Previous commands 
in the Record menu (or press the  o 

 buttons on the toolbar); select now the Delete command in the Record menu (or press 
DEL) ; after answering to the confirm request, question number 2 is deleted.

Show now question number 2 and select the Insert command in the Record menu (or press the
 button in the toolbar): this way you can insert a new question.

Select the Multiple choice with 4 answers pressing the relative button and insert in the first 
text box the following question: "Which is the smallest planet in our Solar System?" (without 
quotation marks).
In the first tab of the second text box insert "Mercury", in the second tab "Venus", in the third 
"Jupiter" and in the fourth "Pluto". Select the right answer number 4 and as hints number 1 
and 4.
To confirm the entered question, select the Confirm command in the Record menu (or press
the  button on the toolbar or press F8).

Select now the Record command in the Edit menu (or press the  button in the toolbar) 
and choose the Insertion type pressing the relative button. Change the current question into 
"Which is the biggest planet in our Solar System?".
In the first tab of the second text box insert the right answer "Jupiter".
To confirm the new question, select the Confirm command in the Record menu.

 Next lesson: Setting evaluation    



 Setting evaluation

 Previous lesson: Deleting, inserting and editing questions 

At the end of the questionnaire / survey execution on screen, WinAsks Player can show an 
evaluation which can be entirely selected by the user.

Select the Evaluation... command in the Questionnaire menu to show the evaluation 
window.
An evaluation is made up of single evaluation bands created according to your needs. Every 
evaluation band is defined by a Lower bound and an Upper bound, by a Description and 
eventually by an Image, a Sound, an Animation and a Video.

Bounds can be considered as Points or Percentages, according to the selected option. 
Using Points option, to characterize the evaluation band the program calculates the score 
obtained by the user and, according to it, the correspondent evaluation is shown. 
Instead using the Percentages option, to characterize the evaluation band the program 
calculates the % of right answers realized by the user and, according to it, the correspondent 
evaluation is shown.

Let's select the Points option and add 4 evaluation bands pressing 4 times the Add button; 
in the first row insert 0 as lower bound and 1 as upper bound; in the second row 1 and 2; in 
the third 2 and 3; in the fourth 3 and 4.
In the first row insert the description "Insufficient"; in the second "Sufficient"; in the third 
"Good"; in the fourth "Excellent".

Now the evaluation has been defined. If we consider a questionnaire made up of 4 questions 
(each one of value 1), if the user gives no right answers then the evaluation # 1 (0 points) is 
shown; if the user gives one right answer the evaluation # 1 (1 point) is shown again; with 2 
right answers the evaluation # 2 (2 points) is shown; with 3 right answers the evaluation # 3 
(3 points) is shown; with all right answers the evaluation # 4 (4 points) is shown.

 Next lesson: Creating a summary 
 



 Creating a summary

 Previous lesson: Setting evaluation 

A summary indicates, as the name itself says, a whole of subjects presented to the user that 
this way has the possibility to choose which is the subject to be treated.
To create a summary in WinAsks Professional you have to use the program Contents 
Designer.

Before starting with its creation however some preliminary operations are necessary. Each 
topic of a summary can contain other topics or it can be directly represented by:

 Texts

 Images, sounds, animations, videos

 Questionnaires

Besides these elements (which are directly supported by the program) Contents Designer can 
use any other file; in this case it will only load the file in the associated application.
For our example, we'll use two texts and a questionnaire.

The two text files can be realized with any editor (for example Windows Notepad). The first file, 
saved as FILE1.TXT contains the text "This is an example of summary realized with WinAsks 
Professional. Select next topic to run the questionnaire" (without quotation marks); the second 
file, saved as FILE2.TXT, contains the text "This summary is an example". For the questionnaire 
we'll use the one created following the lesson Compiling questionnaires / surveys; if you have 
not followed this lesson, the questionnaire is already available with the name SAMPLE.ASK.

After loading Contents Designer, in the text box Element insert "Chapter1" (without quotation
marks) and press the Add button. Select with a click the element Chapter 1; in the text box 
Element enter "Introduction", in the File box press ... button, choose FILE1.TXT and press the 
Add button. Select again with a click the element Chapter 1; in the text box Element insert 
"Questionnaire", in the File box press the ... button, choose file SAMPLE.ASK and press the 
Add button.
Now to insert an element at the initial level (that is at the same level of Chapter 1) right-click 
the current summary; in the text box Element insert "Information", in the File box press the ...
button, choose file FILE2.TXT and press the Add button. Then the summary is created!

To add this summary to the list of the installed questionnaires which appears in the list New...
of WinAsks Player, save the summary and select the Add to list command in the File menu.
Another very important option is Keep links in the Options window. Selecting this option, 
WinAsks Player will search for the summary files in their original path while, on the contrary, it
will search in the directory where the summary is installed. 



 Compiling questionnaires / surveys

After you have created a questionnaire / survey, it has to be compiled to be run on screen, 
that is it has to be converted in a format supported by WinAsks Player.
Selecting the Compile... command in the File menu (or pressing F9) the compilation window 
will be opened.

Press button ..., insert the name "test" for the compiled questionnaire / survey (without 
quotation marks) and press Ok.
Now to compile the questionnaire / survey press the Ok button; at the end of the compilation,
WinAsks Editor shows a statistics window. Shown statistics include compiled file name and 
its path, its single size (the file itself) and its total size (including eventual associated objects),
its identification code, the number of disks used and compilation time.
To continue press Ok.

If you compile the questionnaire on floppies, you can include a personalized installation 
program (pressing Installation... button) with all the necessary to run the questionnaire. This 
way the created disk can be distributed immediately and the main program will not be 
requested to execute the questionnaire.

More questionnaires can be compiled on a floppy: when the disk will be installed, a list of the 
present questionnaires will be shown so that the user will be able to choose the ones he/she 
needs. To compile more questionnaires on a floppy, proceed normally for the first 
questionnaire. When you compile the next ones, WinAsks will "notice" that there's already a 
questionnaire on the disk and will permits you to insert the current one (the old questionnaire 
is not deleted) 

 Next lesson: Printing questionnaires / surveys



 Printing questionnaires / surveys

 Previous lesson: Compiling questionnaires / surveys 

A questionnaire / survey created with WinAsks Editor can also be printed to be filled 
traditionally on paper.
Printing is very simple, because you need only to select the Print... command in the File 
menu. To print immediately all the questions, you can press the Ok button.

Anyway, WinAsks lets you completely customize print layout (that is as questionnaire will be 
printed, fonts, styles, colors, ...); to set your options, press the Options.....button. 
We want to print questions in bold style (that is more evident) select then the Font... tab and, 
in the elements list, select Questions. Press the Font... button and select Bold. Confirm all 
the selected options and return to the print window

Now we want to print 2 copies of the questionnaire, one different from the other. Insert 2 in 
the text box Copies and 2 again in the text box Versions. WinAsks will print therefore 2 
copies of the questionnaire with the same questions, but differently ordered (it just makes two
versions of the same questionnaire).

In the Print list select Print questionnaire with one copy of compact keys, and press the Ok 
button. 
WinAsks will print two different copies of the questionnaire (questions in bold style) and a 
sheet containing the solutions of each questionnaire (two solutions then) 

 Next lesson: Exporting questionnaires / surveys 



 Exporting questionnaires / surveys

 Previous lesson: Printing questionnaires / surveys 

A questionnaire created with WinAsks Editor can be exported and converted in text format to 
be used by other applications.
Selecting the Export... command in the File menu the exportation window is shown. 
Activate the Data request check box and use the other default options; press the Ok button. 
Insert the name "Test" (without quotation marks) and press again the Ok button. 
So the current questionnaire / survey is exported and converted in text format.

To show export result, let's use the internal editor of the program: select then the Text 
command in the Window menu. Select the Open button in the File menu and double-click 
file TEST.TXT; so the exported questionnaire / survey is shown on screen.



 Executing questionnaires / surveys on screen

You can run a questionnaire / survey on screen using the program WinAsks Player. 
After its loading, WinAsks Player shows the New... window containing two tabs: 
Questionnaires and Instructions. In the first one there is a list of the questionnaires / 
surveys that are already present in the current system. Close the window pressing the Close 
button (or pressing ESC) and select the Open... command in the File menu ( or press the  
on the toolbar); choose file SAMPLE.ASK and, pressing Ok, the questionnaire is loaded. To 
begin its execution on video, select the Start command in the Questionnaire menu ( or 
press 

 on the toolbar or press F5). Insert your data and press the Continue button.

So the first question is shown; to choose the right answer among the 4 ones click an arrow, 
to change answer click another arrow, to cancel answer click the currently selected arrow. To 
confirm your answer press the Check button.
In the second question you must insert manually the right answer in its respective text box; to
confirm the answer press the Check button.
In the third question you must specify if each sentence is true or false. To choose true click T,
to choose false click F, to cancel the answer click current selection.
In the fourth question you must associate each sentence with the respective completion. To 
do it, select it in the list on the left; to cancel the answer select the null answer for each 
assertion. 

 Next lesson: Executing printed questionnaires / surveys



 Executing printed questionnaires / surveys

 Previous lesson: Executing questionnaires / surveys on screen 

A printed questionnaire / survey is filled up normally like the others questionnaires.
Answers therefore can be given directly on the sheet, that will be given then to whom collects
the results.

If the questionnaire is for educational use and more versions are printed (to avoid, or at least 
to limit, answers copy) WinAsks can print also the solutions of each version. This way the 
teacher can compare immediately given answers with right answers and define an 
evaluation.



 Collecting and loading data

All the answers given by the users who have filled up the questionnaire / survey can be 
automatically collected and loaded in WinAsks Editor for successive analyses.

Activate the window for data analysis selecting the New analysis command in the File menu
(or pressing     on the toolbar). This window has a spreadsheet outlook and its use results 
then facilitated. Each column represents a question while each row represents a different 
user.

Let's load automatically some reports (that is files containing the given answers). Select the 
Add automatically... in the Record menu ( or press the  button on the toolbar): in the 
directory SAMPLES of WinAsks, there are 10 sample reports. You need only to select one, 
press the Ok button and WinAsks Editor will load automatically all the other reports that refer 
to the same questionnaire (that is: all) 
Reports are loaded in an "intelligent" way: if in the same directory there had been other reports 
referred to other questionnaires, WinAsks Editor would have noticed it and would have loaded 
only the really necessary ones.

Now all reports are shown in a window; for each report you can show some general options 
(score, time, errors, etc.), given answers, used hints, etc.
Let's transfer data of interest from this window to the main table, for a successive analysis. In
the General tab click on the Surname column title and, holding down mouse button, drag it 
on the column title Age; this way the three columns Surname, Name and Age will be 
selected. Press the Copy... button, make sure that in Which records do you want to copy?    
the option Selected ones in current tab is selected and press Ok.
Still in the General tab, click the Total score column title; this way all the column will be 
selected. Press the Copy... button , be sure that in Which records do you want to copy? the 
option Selected ones in current tab is selected and press Ok.
Activate then the Answers tab and press the Copy... button; in Which records do you want to
copy? select All ones in the current tab and press Ok.
Finally press the Close button. So in the main table all the data are ready for an analysis, a 
print or only a look.

To get simpler we have only transferred Surname, Name, Age, Score and Answers; of course
any data (results, hints, times, ...) can be transferred in the main table.

The following steps are not expressly required, but they're often necessary because a 
question is too long to be visualized completely in the column title.
Double-click column header Score... and insert the name Score; double-click column header 
1. When... and insert 1. War; double-click column header 2. When... and insert 2. War; finally
double-click column header 3. Which month... and insert Atomic bomb. 

We've finished! All the data have been entered correctly in WinAsks Editor!

 Next lesson: Statistics and automatic filters 





 Automatic statistics and filters

 Previous lesson: Collecting and loading data 

WinAsks Editor provides several features for data analysis: one of them, the most simple and
immediate, is represented by automatic statistics and automatic filters.

To describe these two functionalities we'll use the data obtained following the previous lesson
Collecting and loading data. If you've not followed it, data are already available on disk in the 
subdirectory SAMPLES with the name TUTOR.ANL.

Let's observe automatic statistics. You often need to calculate for example the mean of 
realized scores, the maximum value, the minimum value, etc. WinAsks Editor has made all 
this information available with only one click! 
For example let's select realized scores: click the first cell of column Score (that is the cell 
containing 2) and, holding mouse button down, select all the scores of this column. Now, 
releasing mouse button, 10 cells will be selected; in the status bar (the bar at the bottom of 
the screen) statistics will be immediately calculated and shown. Now we know that the mean 
of the realized scores is 1.90, the maximum value is 3, the minimum one is 0, etc.
The same operation can be repeated for any data type (for example try with the Age column).
Therefore automatic statistics represent an important feature that lets you know quickly and 
easily the main statistics of current data.

Let's observe the automatic filter; when you treat many data (but not only) is useful, maybe 
necessary, to have the possibility to focus your attention only on the data which at the 
moment are more explanatory than others. For example referring to the already available 
data of our table, it would be useful to know and show only the adults who have answered to 
our questionnaire.
For this purpose, WinAsks Editor provides the automatic filter, that lets you show only the 
selected data.
Select any cell of the Age column (ex. the first cell), right-click and choose the Automatic 
filter command. At column top you'll see two new cells which let you set the options of the 
automatic filter. In the first cell select Greater than and in the second 17, after doing it you'll 
see only adult users, that is only user that are 18 or older.
Moreover you can use more filters at the same time, activating one for each column.
After a filter has been activated, it can be removed unselecting the Automatic filter 
command (always in the pop up menu that appears pressing right mouse button).
In the second list of each automatic filter (the one where column data appear) the (All) value 
is always available; selecting it, all the value will be shown (so returning to initial situation).

 Next lesson: Data frequency and sorting 



 Data frequency and sorting

 Previous lesson: Statistics and automatic filters 

In this section we'll describe you two functionalities of WinAsks Editor; more precisely data 
sorting and data frequency. Using data sorting you can for example show best scores, list user 
who have answered in alphabetically order, etc. Frequency instead lets you know how many 
times a certain answer was given.

To describe these two functionalities we'll use the data obtained following the previous lesson 
Collecting and loading data. If you've not followed it, data are already available on disk in the 
subdirectory SAMPLES with the name TUTOR.ANL.

Let's begin to observe data sorting. Select Sort command in the Record menu (or press  
button on the toolbar). In the first table, in the column Sort by... select Surname and press the 
Sort button. All the data will be shown in the second table; however as you can see the first 
three user have the same surname; in this case it would be useful to sort their name too. So 
press the Add button to add a new sorting criterion and in the column Sort by... select Name. 
Pressing again the Sort button data will be sorted first by surname and then by name.
The sorted data can be transferred in the main table for further analyses: select in the 
Destination list the Sorted tab and press Ok.

Let's observe now data frequency. First of all choose command Select all in the Edit menu 
to select all the data in the table. Then select the Frequency command in the Analysis 
menu (or press the  on the toolbar) Automatically WinAsks Editor calculates and shows 
the frequency of each datum for each question; for example we can see that there are three 
people (corresponding to 30 % of total) that have surname Collins, 1 person (10 %) with 
Zangwill, 2 people (20 %) are 24 , etc.
Like sorting, also data frequency can be transferred in the main table for further analyses.

 Next lesson: Creating charts 



 Creating charts

 Previous lesson: Data frequency and sorting 

All the data and analyses can be represented using explanatory charts that subsequently can 
be printed and/or exported in other applications.
To create a chart, WinAsks Editor provides a Chart Wizard, that makes all the procedure quick 
and easy: you need only to answer some questions.

To describe this functionality we'll use the data obtained following the previous lesson Collecting
and loading data. If you've not followed it, data are already available on disk in the subdirectory 
SAMPLES with the name TUTOR.ANL.

As an example, let's create the charts of the age of the first three people who have answered
to our questionnaire / survey. Click first cell of the column Name (the cell that contains Mark) 
and, holding mouse button down, drag the selection to the third cell of the Age column (the 
cell containing 17). Now 6 cells are selected, three for each column. Select the Chart 
Wizard... command in the Chart menu (or press  button on the toolbar) and press the 
Next button. Choose 3D Bars type and press Next; select the Add values option and press 
Next; insert the main title Example and press Next again. Now we've finished; to create the 
chart press the Create chart button.

The created chart can be modified setting and customizing several options (ex. titles, colors, 
styles, fillings, etc.); it can also be exported to be used in other applications.





Introduction

Planning and creation represent the first step of the use of a questionnaire / survey. 
WinAsks Editor allows you to add, insert, change questions and to completely customize the 
questionnaire / survey to adapt it to your needs and requirements. 



Toolbar

The toolbar is the bar of the main commands listed in the program menus. Using its buttons, you can 
have quicker access to program functions, instead of using the same commands in the menus. Each 
toolbar button, when you move the button over it, shows a description of its function; if you right-click a 
button, you'll see a more complete description of its function



 Introduction

Distribution represents the second step of the use of a questionnaire / survey.
WinAsks Editor, the program for the creation of questionnaires / surveys, allows you both to print them to 
distribute in the traditional paper format, and to compile them to run directly on screen. WinAsks Editor 
can also create a personalized disk containing the questionnaire / survey to be distributed and all the 
necessary files.



Introduction

Questionnaire execution represents the step phase of the use of a questionnaire / survey.
Differently from the other phases this is not carried out by the questionnaire's author but from the people 
who have to answer to the questions.
The questionnaire can be filled in both on paper (printed) and directly on the screen (compiled); if you 
choose the second possibility, the data will be immediately available to be imported and used by analysis 
functions.



Introduction

Data collection and analysis represent the fourth step of the use of a questionnaire / survey.
WinAsks Editor permits to load automatically all the data and provides many functions for their analysis: 
you can calculate statistics, apply filters, create cross tables, etc.
Moreover data are presented in the familiar spreadsheet format, making the program much more easy to 
use.



 Hints...

The questionnaires / surveys created with WinAsks can be completely personalized and fitted to your 
needs. In spite of this you should keep in mind some rules during questionnaires / surveys creation. 

For example, a questionnaire should be created using few fonts, preferably only one font, since this way 
the questionnaire would be more readable, both on paper and on the screen.
If the questionnaire will be run on screen, the font to select is "Ms Sans Serif", while "Times New Roman" 
or "Arial" fonts are the more proper for print.

Furthermore a questionnaire should never contain more than 50 questions, since of course a user would 
not feel at his ease in answering    to many questions and his attention would decrease gradually.
If the questionnaire will be used on the screen, then it's very important to have the possibility of using 
multimedia objects (images, sounds, videos, etc.) which attract the user and get him involved in carrying 
out the questionnaire.



 Hints...

Questionnaires created with WinAsks therefore can be distributed in a great variety of ways. The best is 
compilation, because the questionnaire / survey can be run directly on the screen and the answers will be
automatically saved.

WinAsks Player (the "runtime" to execute questionnaires) can use all the questionnaires created by 
WinAsks Editor; this way you can distribute only one copy of the Player (even if more questionnaires are 
used).
Another easy way is distributing only the questionnaires, letting the user the possibility to find the Player, 
for example downloading it freely from the BBS or the Internet site of SmartLite Software.



 Hints...

As already said, questionnaires / surveys can be filled up on paper or on screen. 
In the first case they're similar any other type of questionnaire, and so there's no difficulty in their filling. 
In the second case they're run on the screen using WinAsks Player; this program is very easy and 
immediate to use, so even an unskilled user can learn to use it quickly



 Hints...

Most of the necessary analyses can be made directly inside WinAsks, using its functions. Anyway, all the 
data can be exported in other applications, so that further evaluations can be performed. Charts can be 
exported too; for example, in a graphics    or a presentation program, etc.

Moreover, performed analyses can be only shown or printed on paper too.



Summing up...

This tutorial has only shown some features of    WinAsks Professional, while the other ones can be 
discovered using the program directly, consulting its on-line help or reading the manual.
WinAsks helps the user in the entire procedure necessary to use a questionnaire / survey and, in this 
case, no other additional programs are necessary.

If you have problems in using WinAsks, don't hesitate to contact us; we'll be glad to give you all the 
necessary explanations!
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